
Windows 10 TechSkills
HINTS, TIPS & SHORTCUTS



Windows 10

• Remember to do these 
everyday essentials to 
keep your work safe..

Essentials

• Check out these useful 
keyboard shortcuts that 
can be used every day..

Shortcuts & Context 
Menus

• See what’s happening 
inside your PC if there 
appears to be a problem..

Task Manager
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• Learn how to effectively 
store your data and find it 
efficiently when needed..

File & Folder 
Management

• Make it easier to use your 
PC by changing personal 
accessibility settings..

Accessibility Settings

• View all your open 
windows at once and use 
multiple virtual desktops..

Task View & 
Snapping Windows
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• Lock your workstation Win + L
Before leaving your workstation to collect a print, chat to friends or visit the toilet simply press the Windows key and L 
key on your keyboard together. This locks the workstation until you use your password to unlock it on your return. 
Leaving your workstation unlocked means anyone can access your account using your credentials while you are away.

• Save your work regularly CTRL + S
How important is your work to you? Suppose you’ve spend hours working on a project when the unexpected happens.. 
The computer freezes or refuses to accept your changes.. The last time you clicked save was over two hours ago.. 

• Don’t rely on portable mass storage devices
By portable mass storage devices we mean USB memory sticks, SD cards, CDs, DVDs – even your own laptop or other 
mobile device, all these devices can fail either physically or electronically resulting in large amounts of lost data.

• Save current work on your network drive (Z:)
Network drives at Edge Hill University are backed up regularly and automatically. This means files you are working on 
should be safe and recoverable if you save them on your (Z:) drive. Data may be recoverable up to the last point it was 
saved for up to 10 days. Your (Z:) drive can store a maximum of 1Gb of data.
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• Backup and archive work to OneDrive

One Drive is a secure cloud based file storage facility with up to 1TB (1000 GB) of  personal space that can be accessed 
through any connected device with an internet browser; log in via the link  on the Edge Hill website student portal page 
https://www.edgehill.ac.uk/students using yourstudentnumber@edgehill.ac.uk Upload files by dragging them onto 
the OneDrive window where a copy of your file is created automatically. You can also create and name folders on your 
OneDrive to keep your files organised.

• Don't unplug a USB mass storage device while transferring files

If you need to use a USB memory stick or portable hard drive make sure your computer has finished transferring  files to 
it before unplugging it; if the USB device light is flashing quickly it is likely files are still transferring. The same applies
when transferring files from a USB device to your computer.

Note:

If your own computer is using an older Operating System such as Windows 7 or 8 it is necessary to “eject” USB drives 
first before physically unplugging them. Click the small arrow in the task bar then click on the USB icon displayed.. 
Choose the correct device from the options shown and click it.. This will tell the computer to eject (disconnect) the 
device and help prevent any data loss or the possibility of your device not being recognised when used with another PC.

We recommend following the same procedure when using Windows 10 even though there is a lower risk of data loss.

https://www.edgehill.ac.uk/students
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• Alt + Tab: Switch between open programs.

• Ctrl + Shift + Esc: Open Task Manager.

Task manager displays information about your computer’s performance & running applications.

• Win + S: Open the search interface for files and folders.

• Win + D: Hide or display the desktop.

• Win: Open the Start menu – simply start typing an application’s name to find it in the list.

• Win + Shift + S: Copy an area of the screen to the clipboard ready to be pasted into an application.

• Ctrl + Left or Right Arrow: Move the cursor forward or back one word.

• Ctrl + Up or Down Arrow: Move the cursor forward or back one paragraph.

• Win + Down/Up Arrow: Make the active window shrink then minimize/Make the active window grow then 
maximize.
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• F1: Open the Help menu for the active application.

The F1 key opens the Help section of almost every application.

• Win + F1: Open Windows 10 Help and Support.

Pressing the Windows key together with the F1 key opens the Microsoft Windows 10 Help Pages.

• Win + Tab: Open Task View.

Task View makes it easy to quickly locate an open window and manage virtual desktops.

• Contextual Menus appear when the right mouse button is clicked offering a limited set of choices based on 
the application's current state. They are a useful way to quickly perform common actions. 

• There many different options shown depending on the open application or where the cursor focus is – some 
of the most useful include New, Send to, Open with, Add to Quick Access and the usual Cut, Copy & Paste.

• Some other helpful right click actions include:

• Refreshing the desktop if icons fail to appear after a network dropout

• Starting a PowerPoint in presentation mode at the first slide

• Moving a file directly to OneDrive



Task Manager
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• Task manager provides you with information about your computer’s performance & running applications; it 
also provides you with the means to manually close an application that has stopped responding.

• The interface can be accessed by using the keyboard combination Ctrl + Shift + Esc or Ctrl + Alt + Delete then 
choosing Task Manager from the menu presented on screen.

• Task Manager is organised using a tabbed layout – by clicking on the different tabs at the top of the Task 
Manager window you can view useful information and take any required action.

• The Processes tab is usually already selected in Task Manager – this shows you performance information 
about individual applications and gives you the opportunity to end a non-responsive application by selecting 
it then clicking the End Task button at the bottom of the window or by simply pressing the Delete key.

• The Performance tab provides a useful overview of tasks the computer is engaged in including what 
percentage of the central processor is being utilised, how much memory is in use and how fast data is 
travelling backwards and forwards across the network connection.
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• View Tab – after opening File Explorer (Win + E) there will be three tabs displayed in the top left hand corner 
of the window. Click the View tab to access all the different options available to view details of files. Click the 
drop down arrow on the far right to keep the options ribbon displayed or to hide it.

• Preview Pane – Clicking on this option displays a preview of file contents in a panel on the right hand side of 
the File Explorer window, this is a great way to quickly preview the content of files.

• Details Pane – Selecting this option displays the properties of each file as it is selected; useful information 
includes author, file size, last modified date etc. Office files also offer the option to add your own comments 
and specify tags to make searches more efficient.

• View Properties – another way to quickly view a file’s properties is to select it then press Alt+Enter.

• Renaming Files – a quick way to rename a file is to select it, press the F2 key then simply type in the new 
name.

• Sort Options – on the top ribbon of the File Explorer window there's an icon named Sort by - clicking the icon 
displays different ways of sorting the files and folder displayed. One of the options is tags as referred to in 
the previous section which makes it easy to sort files using key words.



File & Folder Management
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• Searching For Files – Open File Explorer (Win + E) then do one of the following to select where to search:
• click a folder displayed in Quick Access.. or..
• double-click a folder displayed in Frequent Folders.. or..
• click on This PC to display available drives, then double-click a drive.

• Once the relevant folder or drive name is displayed in the search box located at the top right of the window 
click to select it and enter the search term or a tag if you know one has been added to a file. A new ribbon 
will appear at the top of the window with multiple search options, make sure the All Subfolders icon under 
the Search tab has been selected so the search will include all folders that are contained within the folder you 
are searching. There are also other filters available such as Date Modified, Kind and Size that can make 
searching large drives much quicker.

• Adding files and folders to the Quick Access list - right click on a folder to add (pin) it to the Quick Access list 
in File Explorer.

• Compressing a file or folder – to quickly compress  (Zip) a folder or to group files to send as one email 
attachment right click on the folder/files and select Send to > Compressed (zipped) folder.



File & Folder Management
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• Recovering documents from the network

• In the rare a event a current document that you may be working on becomes damaged or unstable in some 
way and it has been saved on your Edge Hill network drive (Z:) a recent previous version may be recoverable 
in some circumstances.

• There are two ways to check if a previous version of a document can be recovered.

• Open the Word document and click the File tab, click on Info then the Manage Document icon. Unsaved 
document options will be displayed if available.

or
• Open File Explorer and navigate to the file. Right-click on the file, choose Properties and then select the 

Previous Versions tab. Previous version options will be displayed if available.
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• Start > Settings > Ease of Access – Many useful accessibility tools are built into Windows 10 – they are all 
designed to make it easier to interact with your computer.

VISION

• Display – You can make text display up to 200% bigger in all applications to make it easier to read.

• The Night Light option can remove blue light from the screen that may affect quality of sleep after using a 
computer in the evening.

• Cursor & Pointer Size – Making the mouse pointer larger and the cursor wider makes them easier to see.

• Magnifier – Press and hold the Windows key then press the + key to start the magnifier tool. Press the 
Windows key and Esc key to turn off the magnifier tool. There are many different options to choose from.

• Colour Filters – Colours can be inverted, changed to greyscale or altered to help with colour blindness.

• High Contrast – There are various colour themes to choose from or custom colours can be chosen.

• Narrator – Highlighted text is spoken by a synthesized voice if headphones or loudspeakers are connected.



Accessibility Settings
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HEARING

• Audio – A useful feature for people with challenges related to hearing is being able to set Visual Alerts so 
when an alert sound is played by the computer a chosen area of the screen will flash. Should you have 
trouble hearing sound in stereo, it might help to set Windows 10 to convert all stereo audio to mono audio 
automatically.

• Closed Captions – Allows control over the way some closed captions are displayed in Windows 10.

INTERACTION

• Speech – Speech Recognition enables users to dictate text and control some functions of the computer.

• Keyboard – Use an On-Screen Keyboard on touch devices and enable Sticky, Toggle and Filter keys.

• Mouse – Mouse Keys allows control of the mouse pointer by using the arrows included on the numeric 
keypad.

• Eye Control – Facilitates the use of eye tracking technologies to control peripherals such as a mouse & 
keyboard.



Task View & Snapping Windows
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• Task View provides an easy way to see all your open windows on the screen at once and choose the one you 
want to work on. It is similar to using the Alt + Tab shortcut which allows you to cycle through open windows 
however Task View also displays a timeline of recently opened windows and allows the use of Virtual 
Desktops.

• Open Task View using Win + Tab or click on the Task View icon located at the far left of the taskbar.

• To create a new Virtual Desktop enter Task View and then click the text link + New Desktop located in the top 
left-hand corner of the screen.

• To navigate between your original desktop and the newly added virtual desktop(s) click on Desktop 1 or 
Desktop 2 etc. to make them full-screen. In Task View, you can also drag-and-drop open application windows 
from one desktop to another which makes it easy to organize your workspaces.

• Snapping windows is an quick way to divide your screen efficiently when you need more than one window 
accessible at once – Windows 10 will neatly snap the selected window to the left or right with a shortcut.

• Select the window you want to position in half the screen by clicking on the window’s title bar. Press the 
Windows key + Left Arrow key to snap the window to the left half of the screen or the Windows key + Right 
Arrow key to snap the window to the right half of the screen.
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